NVIDIA Control Panel for Quadro Professional Drivers

User’s Guide
Table of Contents

Chapter 1  Introduction...................................................................................................1
  About the NVIDIA Control Panel ..............................................................................2
    Overview..................................................................................................................2
    Changes in Release 440 .........................................................................................2
    Supported Operating Systems ..............................................................................3
    Supported NVIDIA Products ..............................................................................3
    Supported Languages ............................................................................................4
  Getting Support and Information ............................................................................5
    Online Help .............................................................................................................5
    Technical Support ..................................................................................................5
    System Information ................................................................................................5

Chapter 2  Understanding the NVIDIA Control Panel ..................................................6
  Opening and Closing the NVIDIA Control Panel .....................................................7
    Opening the NVIDIA Control Panel ......................................................................7
    Closing the NVIDIA Control Panel ......................................................................7
  About the NVIDIA Control Panel Interface .............................................................8
    Using the Main Task Area .....................................................................................9
    Using the Select a Task Pane .................................................................................9
    Using the Tool Bar ...............................................................................................10
    Using the Menu Bar .............................................................................................10
      File Menu ............................................................................................................10
      Edit Menu ...........................................................................................................11
      Desktop Menu ....................................................................................................11
      Help Menu ..........................................................................................................12
      Group-Specific Menus .......................................................................................13

Chapter 3  Accomplishing NVIDIA Control Panel Tasks ..............................................15
  NVIDIA Control Panel Feature List ........................................................................15
  NVIDIA Control Panel Groups ..............................................................................22
    Using the Display Pages ......................................................................................22
    Using the Video Pages ..........................................................................................22
    Using the 3D Settings Pages ................................................................................22
    Using the Licensing Pages ...................................................................................23
    Using the Developer Pages ..................................................................................23
    Using the Workstation Pages ...............................................................................23
  Using NVIDIA SLI Technology 24
# Table of Contents

Overview of SLI Technology for NVIDIA Quadro Cards ..................................................25  
SLI Modes for NVIDIA Quadro GPUs ..............................................................................25  
  - SLI Frame Rendering Mode ..................................................................................25  
  - SLI Full Scene Antialiasing Mode ........................................................................25  
Hardware Requirements ..................................................................................................26  
Installation Instructions ..................................................................................................27  
  - Installing the Hardware ..........................................................................................27  
  - Installing the Display Driver ..................................................................................28  
Using NVIDIA SLI Frame Rendering or SLI Antialiasing Modes ........................................29  
  - Enable SLI Mode ....................................................................................................29  
  - Selecting SLI Frame Rendering .............................................................................30  
    - SLI Frame Rendering for ACE-Detectable Applications ....................................30  
    - SLI Frame Rendering for Non-ACE Detectable Applications with no Global Preset 31  
  - Using the Preset 3D App Profiles .........................................................................31  
  - Selecting SLI Full-scene Antialiasing ..................................................................32  
  - Selecting SLI Single-GPU Mode ............................................................................32  
Viewing the SLI Visual Indicators ....................................................................................33  
SLI Multi-OS – GPU Assignment in System Virtualization .............................................35  
Mosaic Technology ........................................................................................................35  

## Multi-GPU Systems 36

Configuring Multi-GPU Displays in the NVIDIA Control Panel ........................................37  
Understanding Multi-GPU Displays in the Windows Display Properties Settings Page 39  
Overview of Dualview Monitors in a Multiple-GPU System ............................................39  
Monitor Order ...............................................................................................................39  
  - Monitor Order Example .........................................................................................40  
Monitor Icons ...............................................................................................................40  
  - Monitor Order Example .........................................................................................40  
Monitor Icons: nView Clone and Spanning Mode ..........................................................41  
Determining GPU Order ..................................................................................................41  
Default GPU Order .........................................................................................................41  
Monitor Order After Changing the GPU Boot Priority in the BIOS ..................................41

Professional 3D Stereo 43
# Table of Contents

About Workstation 3D Stereo ................................................................. 43
   Basic Workstation 3D Stereo Requirements ........................................ 43
   Using 3D Stereo under Different System Configurations ................... 44
Using Workstation 3D Stereo ............................................................... 44
   Basic 3D Stereo Setup ........................................................................ 44
   Selecting the Stereo Display Mode ...................................................... 45
Using Workstation 3D Stereo with Multiple Displays ......................... 47
   Enabling 3D Stereo with Multiple Displays ....................................... 47
   3D Stereo Under nView Modes .......................................................... 47
   3D Stereo Under Dualview Modes ...................................................... 47

NVIDIA Application Configuration Engine 48
   Introduction .......................................................................................... 49
   Background ......................................................................................... 49
   About NVIDIA ACE ............................................................................ 49
Using ACE with Supported Applications .............................................. 49
   How to Determine ACE Support .......................................................... 49
   Modifying Settings for ACE-detectable Applications .......................... 50
Using Applications that are not Supported by ACE ............................... 51
   Setting Up an Application Profile Using Global Presets .................... 51
   About the Global Presets ................................................................... 52
Adding to the List of ACE-detectable Applications ................................. 53
Frequently Asked Questions .................................................................. 54
List of Figures

Figure 2.1 NVIDIA Control (Windows Vista Example) .................................................. 8
Figure 2.2 NVIDIA Control Panel Select a Task pane .......................................... 9
Figure 2.3 Navigation History Menu ........................................................................ 10
Figure A.1 SLI Visual Indicators ........................................................................... 34
Figure D.1 Manage 3D Settings Page-ACE-detectable applications ....................... 50
Figure D.2 Manage 3D Settings Page-Applications with Global Profiles ............. 51
List of Tables

<table>
<thead>
<tr>
<th>Table</th>
<th>Description</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Table 2.1</td>
<td>File Menu Commands</td>
<td>10</td>
</tr>
<tr>
<td>Table 2.2</td>
<td>Edit Menu Commands</td>
<td>11</td>
</tr>
<tr>
<td>Table 2.3</td>
<td>Desktop Menu Commands</td>
<td>11</td>
</tr>
<tr>
<td>Table 2.4</td>
<td>Help Menu Commands</td>
<td>12</td>
</tr>
<tr>
<td>Table 2.5</td>
<td>Display Menu Commands</td>
<td>13</td>
</tr>
<tr>
<td>Table 2.6</td>
<td>3D Settings Menu Commands</td>
<td>13</td>
</tr>
<tr>
<td>Table 2.7</td>
<td>Workstation Menu Commands</td>
<td>14</td>
</tr>
<tr>
<td>Table 3.1</td>
<td>NVIDIA Control Panel Features</td>
<td>15</td>
</tr>
<tr>
<td>Table B.1</td>
<td>Windows Monitor Numbering Example-Four Connected Displays</td>
<td>40</td>
</tr>
<tr>
<td>Table B.2</td>
<td>Windows Monitor Numbering Example-Six Potential Displays</td>
<td>40</td>
</tr>
<tr>
<td>Table B.3</td>
<td>Windows Monitor Numbering Example-Default Boot Priority</td>
<td>41</td>
</tr>
<tr>
<td>Table B.4</td>
<td>Windows Monitor Numbering Example-PCI Boot Priority</td>
<td>42</td>
</tr>
<tr>
<td>Table C.1</td>
<td>Workstation Stereo Configurations</td>
<td>44</td>
</tr>
<tr>
<td>Table C.2</td>
<td>List of Supported Stereo Display Modes</td>
<td>45</td>
</tr>
</tbody>
</table>
Chapter 1. Introduction

This quick start is addressed to users of the NVIDIA® Control Panel software. This guide focuses on getting you up and running with your NVIDIA software.

For technical details on the features and benefits of the NVIDIA Control Panel software and details about supported products, drivers, and other software, refer to the NVIDIA web page — www.nvidia.com.

This chapter discusses the following major topics:

► “About the NVIDIA Control Panel” on page 2
► “Getting Support and Information” on page 5
Chapter 1: Introduction

About the NVIDIA Control Panel

Welcome to the NVIDIA Control Panel, designed for Microsoft® Windows®. You can use NVIDIA Control Panel to control your NVIDIA hardware and access other NVIDIA software installed on your system.

Overview

In addition to setting up basic display configurations such as display resolution, refresh rate, and multiple display use, you can:

► Tune your 3D settings with real-time preview to maximize performance or image quality
► Customize how 3D applications work in your system
► Adjust your screen colors and contrast
► Set custom timings
► Control video image settings
► Change your HDTV format
► Control special workstation features such as Frame Synchronization.

Note: The NVIDIA Control Panel can be viewed with a desktop DPI scaling set to a maximum of 250%. Setting the DPI higher than 250% may result in some content getting cut off from view.

Changes in Release 440

► Manage 3D Settings page - added Image Sharpening setting.
► Manage 3D Settings page - added Max Frame Rate setting.
► Manage 3D Settings page - added Virtual Reality - Variable Rate Super Sampling setting.
Supported Operating Systems

NVIDIA Release 440 Quadro professional drivers are available for the following Microsoft®
Windows® operating systems:

- Windows 10 64-bit
- Windows Server 2012 R2 (64-bit)
- Windows Server 2016 (64-bit)
- Windows Server 2019 (64-bit)

Refer to the release notes for specific operating system support for individual driver versions.

Supported NVIDIA Products

Refer to the release notes and NVIDIA driver download site for the list of products supported by
the driver version that you have installed on your computer.
## Supported Languages

The NVIDIA Graphics Driver supports the following languages in the NVIDIA Control Panel:

<table>
<thead>
<tr>
<th>English (USA)</th>
<th>German</th>
<th>Portuguese (Euro/Iberian)</th>
</tr>
</thead>
<tbody>
<tr>
<td>English (UK)</td>
<td>Greek</td>
<td>Russian</td>
</tr>
<tr>
<td>Arabic</td>
<td>Hebrew</td>
<td>Slovak</td>
</tr>
<tr>
<td>Chinese (Simplified)</td>
<td>Hungarian</td>
<td>Slovenian</td>
</tr>
<tr>
<td>Chinese (Traditional)</td>
<td>Italian</td>
<td>Spanish</td>
</tr>
<tr>
<td>Czech</td>
<td>Japanese</td>
<td>Spanish (Latin America)</td>
</tr>
<tr>
<td>Danish</td>
<td>Korean</td>
<td>Swedish</td>
</tr>
<tr>
<td>Dutch</td>
<td>Norwegian</td>
<td>Thai</td>
</tr>
<tr>
<td>Finnish</td>
<td>Polish</td>
<td>Turkish</td>
</tr>
<tr>
<td>French</td>
<td>Portuguese (Brazil)</td>
<td></td>
</tr>
</tbody>
</table>
Getting Support and Information

Online Help

▶ To open the online help, either:
  • Press F1 on your keyboard, or
  • Select Help from the NVIDIA Control Panel menu bar and then select NVIDIA Control Panel Help.
▶ Help on various topics can be viewed using the Contents, Index, or Search tabs.

Technical Support

To access the NVIDIA Technical Support web page go the following web address:
http://www.nvidia.com/page/support.html

System Information

You can get detailed information about your system and the NVIDIA Control Panel configuration as well as version and copyright information.

▶ To view copyright and version information about the NVIDIA Control Panel:
  From the Help menu, select About NVIDIA Control Panel.
▶ To view detailed system information:
  Open the System Information dialog box by either selecting System Information from the Help menu, or by clicking the System Information link at the lower left corner of the NVIDIA Control Panel.
  Click any of the tabs in the System Information dialog box.
Chapter 2. Understanding the NVIDIA Control Panel

This chapter describes the NVIDIA Control Panel in the following sections:

► “Opening and Closing the NVIDIA Control Panel” on page 7
► “About the NVIDIA Control Panel Interface” on page 8
Opening and Closing the NVIDIA Control Panel

Opening the NVIDIA Control Panel

You can open the NVIDIA Control Panel in several ways:

- From the Desktop, click the Start icon, then click All Apps->Windows System->Control Panel.
- From the Control Panel, click Hardware and Sound->NVIDIA Control Panel, or
- Click the NVIDIA Settings icon from the Windows taskbar. You may need to click the Show hidden icons arrow.

Closing the NVIDIA Control Panel

To close the NVIDIA Control Panel,

- From the File menu, select Exit, or
- Click the Close box in the upper right corner of the program window.

Note: The NVIDIA Control Panel can be viewed with a desktop DPI scaling set to a maximum of 250%. Setting the DPI higher than 250% may result in some content getting cut off from view.
About the NVIDIA Control Panel Interface

The NVIDIA Control Panel provides an easy-to-use interface for managing your system. When you start the program for the first time, the NVIDIA Control Panel opens to the first page listed in the navigation tree. On subsequent visits, the control panel reopens to the last page visited. The NVIDIA Control Panel user interface consists of these main areas, as shown in Figure 2.1:

- Main Task Area
- Select a Task (Navigation tree)
- Menu bar
- Toolbar

![Figure 2.1 NVIDIA Control (Windows Vista Example)](image)

Figure 2.1 NVIDIA Control (Windows Vista Example)
Using the Main Task Area

The main task area, in the right pane, displays the application task pages. This area of the screen is where you will focus most of your attention as you use the NVIDIA Control Panel to accomplish your goals. You can access specific pages using the navigation tree in the Select a Task pane.

Depending on your PC manufacturer, there is a Welcome page that appears the first time you open the NVIDIA Control Panel after installing the driver. On subsequent visits, the control panel reopens to the last page visited.

Using the Select a Task Pane

The navigation tree in the Select a Task pane shows all the primary NVIDIA Control pages that are installed on your system.

The pages are grouped according to the same categories that existed in the previous version of the NVIDIA Control Panel.

Figure 2.2 NVIDIA Control Panel Select a Task pane
Using the Tool Bar

The **Toolbar** provides quick back and forth navigation between pages. The back and forward buttons let you navigate sequentially among pages that you have visited.

You can also navigate directly to a previously visited page by clicking the list arrow next to the back button. The drop-down menu lists all the previously visited pages in the queue. Click the page that you want.

![Navigation History Menu](image)

Figure 2.3  Navigation History Menu

Using the Menu Bar

The **Menu bar** contains standard Windows menus and menus specific to the NVIDIA Control Panel, such as the View and Profiles menus.

Menus that are available on the menu bar may vary, depending on the NVIDIA Control Panel group (such as, Display, Mobile, 3D Settings, or other group) you are using.

**File Menu**

Commands related to printing, applying changes, and exiting the program are available on the File menu.

**Table 2.1  File Menu Commands**

<table>
<thead>
<tr>
<th>File Menu Command</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Page Setup...</td>
<td>Set up the current task page for printing. This control may not be available.</td>
</tr>
<tr>
<td>Print...</td>
<td>Print the current task page. This control may not be available.</td>
</tr>
<tr>
<td>Print Preview...</td>
<td>Preview the page before sending it to the printer. This control may not be available.</td>
</tr>
</tbody>
</table>
### Table 2.1  File Menu Commands

<table>
<thead>
<tr>
<th>File Menu Command</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Exit</td>
<td>Close the NVIDIA Control Panel program.</td>
</tr>
</tbody>
</table>

### Edit Menu

Commands related to cutting, copying, pasting, and selecting items are available on the Edit menu.

### Table 2.2  Edit Menu Commands

<table>
<thead>
<tr>
<th>Edit Menu Command</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Cut</td>
<td>Cut the selected text and place in the clipboard. This control may not be available.</td>
</tr>
<tr>
<td>Copy</td>
<td>Copy the selected text and place in the clipboard. This control may not be available.</td>
</tr>
<tr>
<td>Paste</td>
<td>Paste the text currently in the clipboard to the location of the Windows cursor. This control may not be available.</td>
</tr>
<tr>
<td>Select All</td>
<td>Select all items on the current page. This control may not be available.</td>
</tr>
</tbody>
</table>

### Desktop Menu

Commands related to viewing the various pages in the NVIDIA Control Panel application modules are available on the Desktop menu.

### Table 2.3  Desktop Menu Commands

<table>
<thead>
<tr>
<th>View Menu Command</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Add Desktop Context Menu</td>
<td>This is selected by default, and adds the NVIDIA Control Panel menu item to the desktop context menu.</td>
</tr>
<tr>
<td>Enable Video Editing Mode</td>
<td>Select this option to improve the video playback experience for some video editing applications.</td>
</tr>
</tbody>
</table>
Table 2.3  Desktop Menu Commands

<table>
<thead>
<tr>
<th>View Menu Command</th>
<th>Description</th>
</tr>
</thead>
</table>
| Add "Run with graphics processor" Option  | Select this option to add "Run with graphics processor" to the program context menu. When this option is selected, you can choose which graphics processor to use when starting a program as follows:  
1. Right-click the program icon.  
2. Click Run with graphics processor and then click the graphics processor to use.  
The selection applies only at the time the program is launched.  
NOTE: This menu option appears only with systems using NVIDIA © Optimus™ technology.  
NOTE: Some programs require elevated user privileges in order to use the "Run on graphics processor" option from the program's right-click menu. A pop-up dialog will let you know if that is the case. In this case, use the controls in the NVIDIA Control Panel->Manage 3D Settings page to select the graphics processor. |
| Display GPU Activity Icon in Notification Area | Select this option so that the GPU Activity icon appears in the Windows notification area of the taskbar. You can then click the icon to see which programs and displays are using the NVIDIA GPU.  
NOTE: This menu option appears only with systems using NVIDIA® Optimus™ technology. |
| Show Notification Tray Icon                | (Windows XP only) Select to show the NVIDIA Control Panel notification tray icon in the Windows taskbar notification area. Clicking the NVIDIA Control Panel notification icon offers a quick way to configure key NVIDIA Control Panel settings. |

Help Menu

Commands related to accessing help, system information, and copyright and version information are available on the Help menu.

Table 2.4  Help Menu Commands

<table>
<thead>
<tr>
<th>Help Menu Command</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>NVIDIA Control Panel Help</td>
<td>Access the NVIDIA Control Panel online help.</td>
</tr>
<tr>
<td>System Information</td>
<td>View detailed information about your system and the NVIDIA Control Panel configuration.</td>
</tr>
<tr>
<td>About NVIDIA Control Panel</td>
<td>View NVIDIA Control Panel version and copyright information.</td>
</tr>
</tbody>
</table>
Group-Specific Menus

These menus appear only when pages from a specific group are open.

Display Menu

This menu item appears only when a Display group page is open.

Table 2.5 Display Menu Commands

<table>
<thead>
<tr>
<th>Display Menu Command</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Identify Displays</td>
<td>Select to identify the displays configured with your system.</td>
</tr>
<tr>
<td>Show G-SYNC Visual Indicator</td>
<td>Select to verify that NVIDIA G-SYNC is being used. Depending on the type of monitor connected, the menu item could state Show indicator for G-SYNC, Show indicator for G-SYNC Compatible, or Show indicator for G-SYNC/G-SYNC Compatible</td>
</tr>
</tbody>
</table>

3D Settings Menu

This menu item appears only when a 3D Settings group page is open on an SLI system.

Table 2.6 3D Settings Menu Commands

<table>
<thead>
<tr>
<th>3D Settings Menu Command</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Show SLI Visual Indicators</td>
<td>Select to verify that SLI rendering or SLI antialiasing is enabled and working.</td>
</tr>
<tr>
<td>Show Multi-GPU Visual Indicator</td>
<td>Select to verify that multi-GPU rendering or multi-GPU antialiasing is enabled and working.</td>
</tr>
<tr>
<td>Show PhysX Visual Indicator</td>
<td>Select to verify the type of PhysX acceleration the game is using - CPU or GPU - or if PhysX acceleration is being used at all.</td>
</tr>
</tbody>
</table>
Workstation Menu

This menu item appears only when a Workstation group page is open.

Table 2.7 Workstation Menu Commands

<table>
<thead>
<tr>
<th>Workstation Menu Command</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Refresh View</td>
<td>Select to refresh the graphical representation of the displays and graphics cards installed on your system.</td>
</tr>
</tbody>
</table>
Chapter 3. Accomplishing NVIDIA Control Panel Tasks

The NVIDIA Control Panel provides an intuitive layout for locating graphics driver controls, including most of the controls that were available with the Classic NVIDIA Control Panel.

- “NVIDIA Control Panel Feature List” on page 15 lists the current features available in the NVIDIA Control Panel.
- “NVIDIA Control Panel Groups” on page 22 provides an overview of the NVIDIA Control Panel pages by group.

NVIDIA Control Panel Feature List

Note: With Optimus systems under Windows 10, the Display controls are not available if no display is connected to the NVIDIA GPU. This is because clone mode across display adapters is handled by the Windows OS and not by the NVIDIA driver.

Table 3.1 NVIDIA Control Panel Features

<table>
<thead>
<tr>
<th>Feature</th>
<th>Values (Default in bold)a</th>
<th>Notes</th>
</tr>
</thead>
<tbody>
<tr>
<td>Display/TV Controls</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Mode control</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Resolution</td>
<td>Non-HD display - the native resolution or the highest safe resolution from the monitor EDID is the default. HD display - the highest progressive resolution is the default.</td>
<td></td>
</tr>
<tr>
<td>Refresh rate</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
Table 3.1 NVIDIA Control Panel Features

<table>
<thead>
<tr>
<th>Feature</th>
<th>Values [Default in bold]a</th>
<th>Notes</th>
</tr>
</thead>
<tbody>
<tr>
<td>Custom timings/resolutions</td>
<td></td>
<td></td>
</tr>
<tr>
<td>TV Signal Format Selection</td>
<td>M/NTSC, PAL, M/PAL, N/PAL,</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Select by country</td>
<td></td>
</tr>
<tr>
<td>Connector Selection</td>
<td>Auto-select, DVI, VGA,</td>
<td>Available values depend on the actual connection.</td>
</tr>
<tr>
<td></td>
<td>S-Video - SDTV, Component,</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Composite - SDTV, HDMI -</td>
<td></td>
</tr>
<tr>
<td></td>
<td>HDTV (Vista and later),</td>
<td></td>
</tr>
<tr>
<td></td>
<td>DisplayPort - HDTV (Vista</td>
<td></td>
</tr>
<tr>
<td></td>
<td>and later), LVDS - laptop</td>
<td></td>
</tr>
<tr>
<td></td>
<td>display</td>
<td></td>
</tr>
<tr>
<td>Desktop Color depth</td>
<td>Highest [32-bit], Medium</td>
<td></td>
</tr>
<tr>
<td></td>
<td>[16-bit], HDR [64-bit],</td>
<td></td>
</tr>
<tr>
<td></td>
<td>WCG [64-bit], SDR [30-bit</td>
<td></td>
</tr>
<tr>
<td></td>
<td>color], SDR [24-bit color]</td>
<td></td>
</tr>
<tr>
<td>Output Color Depth</td>
<td>8 bpc, 12 bpc</td>
<td>Display dependent</td>
</tr>
<tr>
<td>Output Dynamic Range</td>
<td>Full [0—255], Limited [16—</td>
<td></td>
</tr>
<tr>
<td></td>
<td>235]</td>
<td></td>
</tr>
<tr>
<td>Output Color Format</td>
<td>RGB, YCbCr422</td>
<td>For HDMI and DisplayPort connections</td>
</tr>
<tr>
<td>Color Control</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Brightness</td>
<td>0 - 100%, [50%]</td>
<td></td>
</tr>
<tr>
<td>Contrast</td>
<td>0 - 100%, [50%]</td>
<td></td>
</tr>
<tr>
<td>Gamma</td>
<td>0.50 - 1.50, [1.00]</td>
<td></td>
</tr>
<tr>
<td>Digital Vibrance</td>
<td>0 - 100%, [0%]</td>
<td></td>
</tr>
<tr>
<td>Hue</td>
<td>0 - 359 degrees [30]</td>
<td>For GeForce 8 series and later GPUs</td>
</tr>
<tr>
<td>Flicker Filter</td>
<td>0 - 100%, [50%]</td>
<td>For analog TVs</td>
</tr>
<tr>
<td>Gray border option</td>
<td>Disabled</td>
<td>For analog TVs; presents unused black TV borders as gray</td>
</tr>
</tbody>
</table>

a Default values are marked in bold.
Table 3.1 NVIDIA Control Panel Features

<table>
<thead>
<tr>
<th>Feature</th>
<th>Values (Default in bold)¹</th>
<th>Notes</th>
</tr>
</thead>
<tbody>
<tr>
<td>Content type (ITC) reported to the display</td>
<td>Auto select, Desktop programs, Full-screen videos, Photos, Movie, Games</td>
<td>Some HDMI displays only - available values dependent on display support</td>
</tr>
<tr>
<td>NVIDIA G-SYNC</td>
<td>Enable G-SYNC/G-SYNC Compatible</td>
<td>Windows 10 and Pascal or later GPUs required for G-SYNC Compatible displays.</td>
</tr>
<tr>
<td>Rotation</td>
<td>0, 90, 180, 270 degrees</td>
<td></td>
</tr>
<tr>
<td>Desktop Size and Position</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Move CRT screen position</td>
<td></td>
<td>For VGA displays</td>
</tr>
<tr>
<td>Scaling mode</td>
<td>Aspect ratio</td>
<td>TV, VGA (with EDID), Digital displays, LVDS</td>
</tr>
<tr>
<td>Scaling performed on</td>
<td>GPU</td>
<td></td>
</tr>
<tr>
<td>Application Scaling override</td>
<td>Off, On</td>
<td></td>
</tr>
<tr>
<td>Resize</td>
<td></td>
<td>TV, Digital displays</td>
</tr>
<tr>
<td>Position</td>
<td></td>
<td>TV, VGA</td>
</tr>
<tr>
<td>Multi-display Options</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Single-display mode</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Dualview (extended mode)</td>
<td></td>
<td></td>
</tr>
<tr>
<td>nView Clone Mode</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Smart Clone</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Set Up Merge Displays</td>
<td></td>
<td>Windows 10 and later</td>
</tr>
<tr>
<td>Video Controls</td>
<td>“Use video player settings” is the default. If “Use NVIDIA settings” is selected, the following values apply.</td>
<td></td>
</tr>
<tr>
<td>Color Settings</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Brightness</td>
<td>0 - 100%, (50%)</td>
<td></td>
</tr>
<tr>
<td>Contrast</td>
<td>0 - 100%, (50%)</td>
<td></td>
</tr>
<tr>
<td>Hue</td>
<td>0 - 100%, (0%)</td>
<td></td>
</tr>
<tr>
<td>Saturation</td>
<td>0 - 100%, (50%)</td>
<td></td>
</tr>
<tr>
<td>Gamma (including separate RGB)</td>
<td>0.3 - 3.00, (1.00)</td>
<td></td>
</tr>
<tr>
<td>Advanced Color Settings</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Dynamic Range</td>
<td>Full (0—255)</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Limited (16—235)</td>
<td></td>
</tr>
</tbody>
</table>
### Table 3.1 NVIDIA Control Panel Features

<table>
<thead>
<tr>
<th>Feature</th>
<th>Values [Default in bold]a</th>
<th>Notes</th>
</tr>
</thead>
<tbody>
<tr>
<td>Dynamic Contrast Enhancement</td>
<td>Disabled</td>
<td></td>
</tr>
<tr>
<td>Color Enhancement</td>
<td>Disabled</td>
<td></td>
</tr>
<tr>
<td>Image Settings</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Edge Enhancement</td>
<td>0 - 100%, (0%)</td>
<td></td>
</tr>
<tr>
<td>Noise Reduction</td>
<td>0 - 100%, (0%)</td>
<td></td>
</tr>
<tr>
<td>Inverse Telecine option</td>
<td>Disabled</td>
<td></td>
</tr>
<tr>
<td>Internet Video Enhancement option</td>
<td>Disabled</td>
<td></td>
</tr>
<tr>
<td>Digital Audio</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Verify displays that will appear as audio devices in the Windows Sound Settings</td>
<td>For each audio-capable display, select the display or select &quot;Turn off audio&quot;.</td>
<td>For GPUs that support digital audio when an HDMI or DisplayPort connection is made.</td>
</tr>
<tr>
<td>Portal to the Windows Sound Settings panel</td>
<td></td>
<td></td>
</tr>
<tr>
<td>HDCP</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Capability verification page</td>
<td></td>
<td>For GPUs that support HDCP.</td>
</tr>
<tr>
<td>3D Application Controls</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Preferred graphics processor</td>
<td>High-performance NVIDIA processor, Integrated graphics, Force high-performance NVIDIA processor use, Force integrated graphics use, Auto-select</td>
<td>Optimus systems</td>
</tr>
<tr>
<td>Ambient Occlusion</td>
<td>Off, Performance, Quality</td>
<td></td>
</tr>
<tr>
<td>Anisotropic filtering</td>
<td>Application-controlled, Off, card-specific settings</td>
<td></td>
</tr>
<tr>
<td>Antialiasing - Mode</td>
<td>Application-controlled, Off, Enhance the application setting, Override any application setting</td>
<td></td>
</tr>
<tr>
<td>Antialiasing - Setting</td>
<td>Application-controlled, card-specific settings</td>
<td></td>
</tr>
<tr>
<td>Antialiasing - FXAA</td>
<td>Off, On</td>
<td></td>
</tr>
<tr>
<td>Antialiasing line gamma</td>
<td>Off, On</td>
<td></td>
</tr>
<tr>
<td>Antialiasing - gamma correction</td>
<td>Off, On</td>
<td></td>
</tr>
</tbody>
</table>
### Chapter 3. Accomplishing NVIDIA Control Panel Tasks

<table>
<thead>
<tr>
<th>Feature</th>
<th>Values (Default in bold)</th>
<th>Notes</th>
</tr>
</thead>
<tbody>
<tr>
<td>Antialiasing - transparency</td>
<td>Off, Multisampling,</td>
<td></td>
</tr>
<tr>
<td></td>
<td>supersampling</td>
<td></td>
</tr>
<tr>
<td>Buffer-flipping mode</td>
<td>Auto-select,</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Block transfer</td>
<td>NVIDIA Quadro cards</td>
</tr>
<tr>
<td>CUDA - GPUs</td>
<td>[All CUDA-capable GPUs]</td>
<td></td>
</tr>
<tr>
<td>Deep color for 3D applications</td>
<td>Allow, disable</td>
<td></td>
</tr>
<tr>
<td>DSR Factors</td>
<td>OFF</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Available factors depend on system capability. Examples: 1.20x [native resolution] 1.50x [native resolution] 2.00x [native resolution] etc.</td>
<td></td>
</tr>
<tr>
<td>DSR Smoothness</td>
<td>OFF</td>
<td></td>
</tr>
<tr>
<td></td>
<td>0 - 100%</td>
<td></td>
</tr>
<tr>
<td>Exported pixel types</td>
<td>8-bpp and/or RGB555 format,</td>
<td>NVIDIA Quadro cards</td>
</tr>
<tr>
<td></td>
<td>None</td>
<td></td>
</tr>
<tr>
<td>Image Sharpening</td>
<td>Off,</td>
<td></td>
</tr>
<tr>
<td></td>
<td>On:</td>
<td></td>
</tr>
<tr>
<td></td>
<td>- GPU Upscaling check box</td>
<td></td>
</tr>
<tr>
<td></td>
<td>- Sharpen slider</td>
<td></td>
</tr>
<tr>
<td></td>
<td>- Ignore Film Grain slider</td>
<td></td>
</tr>
<tr>
<td>Low Latency Mode</td>
<td>Off, On, Ultra</td>
<td></td>
</tr>
<tr>
<td>Monitor Technology</td>
<td>G-SYNC/G-SYNC Compatible, ULMB, Fixed Refresh</td>
<td></td>
</tr>
<tr>
<td>Multi-display/mixed-GPU acceleration</td>
<td>Single, Compatible, or Multiple display performance modes</td>
<td></td>
</tr>
<tr>
<td>Multi-GPU performance mode</td>
<td>single-GPU, alternate frame rendering 1 &amp; 2, split frame rendering, or multi-GPU antialiasing</td>
<td></td>
</tr>
<tr>
<td>OpenGL Rendering GPU</td>
<td>Auto-select,</td>
<td>NVIDIA NVS cards</td>
</tr>
</tbody>
</table>
Table 3.1 NVIDIA Control Panel Features

<table>
<thead>
<tr>
<th>Feature</th>
<th>Values [Default in bold]a</th>
<th>Notes</th>
</tr>
</thead>
<tbody>
<tr>
<td>Optimize for Compute Performance</td>
<td>Off, On</td>
<td>Windows 10, Maxwell GPUs and later. Offers significant improvement for some Compute applications. Care should be taken when turning this setting ON, as there can be unpredictable effects with some applications and graphics features.</td>
</tr>
<tr>
<td>Power management mode</td>
<td>Adaptive, NVIDIA driver controlled, Prefer maximum performance, Prefer consistent performance, Optimal power</td>
<td>&quot;NVIDIA Driver controlled&quot; GPUs</td>
</tr>
<tr>
<td>Preferred Refresh Rate</td>
<td>Application-controlled, Highest available</td>
<td></td>
</tr>
<tr>
<td>SLI performance modes</td>
<td>single-GPU, alternate frame rendering 1 &amp; 2, split frame rendering, or SLI antialiasing</td>
<td></td>
</tr>
<tr>
<td>Stereo - Display mode</td>
<td>Select to match stereo viewing hardware</td>
<td>NVIDIA Quadro cards</td>
</tr>
<tr>
<td>Stereo - Enable</td>
<td>Off, On</td>
<td>NVIDIA Quadro cards</td>
</tr>
<tr>
<td>Stereo - Force shuttering</td>
<td>Off, On</td>
<td>NVIDIA Quadro cards</td>
</tr>
<tr>
<td>Stereo - Swap eyes</td>
<td>Off, On</td>
<td>NVIDIA Quadro cards</td>
</tr>
<tr>
<td>Stereo - Swap mode</td>
<td>Application Controlled, Per Eye, Per Eye-pair</td>
<td>NVIDIA Quadro cards</td>
</tr>
<tr>
<td>Texture filtering - anisotropic mip filter optimization</td>
<td>Off, On</td>
<td></td>
</tr>
<tr>
<td>Texture filtering - anisotropic sample filter optimization</td>
<td>Off, On</td>
<td></td>
</tr>
<tr>
<td>Texture filtering - Negative LOD bias</td>
<td>Allow, Clamp</td>
<td></td>
</tr>
<tr>
<td>Texture filtering - Trilinear optimization</td>
<td>Off, On</td>
<td></td>
</tr>
<tr>
<td>Threaded optimization</td>
<td>Off, On</td>
<td>For systems with multiple CPUs</td>
</tr>
</tbody>
</table>
Table 3.1 NVIDIA Control Panel Features

<table>
<thead>
<tr>
<th>Feature</th>
<th>Values (Default in bold)(^a)</th>
<th>Notes</th>
</tr>
</thead>
<tbody>
<tr>
<td>Triple buffering</td>
<td>Off, On</td>
<td></td>
</tr>
<tr>
<td>Vertical sync</td>
<td>Use the 3D application setting, Off, On, Adaptive, Adaptive (half refresh rate), Fast</td>
<td>Adaptive settings are available only on Windows Vista and later, and only if Monitor Technology is set to ULMB or Fixed Refresh Rate.</td>
</tr>
<tr>
<td>Virtual Reality pre-rendered frames</td>
<td>Use the 3D application setting, 1, 2, 3, 4</td>
<td>Sets the frame pre-rendering</td>
</tr>
<tr>
<td>Whisper Mode</td>
<td>Off: Disabled by GeForce Experience</td>
<td>Available on Pascal and later GPUs, on single-GPU configurations.</td>
</tr>
<tr>
<td></td>
<td>On: Enabled by GeForce Experience and applied as a Global Setting. Frame rates are capped at 40 or 60 fps, depending on the application. WhisperMode slider: Appears under Program Settings when enabled in GeForce Experience.</td>
<td></td>
</tr>
<tr>
<td>PhysX Configuration</td>
<td></td>
<td>For systems with PhysX-capable GPUs, a minimum of 256MB dedicated graphics memory, and a minimum of 32 processor cores</td>
</tr>
<tr>
<td>SLI/Multi-GPU Configuration</td>
<td></td>
<td>For systems with SLI or multi-GPU ready GPUs.</td>
</tr>
<tr>
<td>3-way SLI Mode</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Quad SLI Mode</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

\(^a\) Defaults for the 3D application controls are for the Global Settings tab. Under the Program Settings tab, **Use global setting** is typically the default setting.
NVIDIA Control Panel Groups

This section provides an overview of the NVIDIA Control Panel groups.

- “Using the Display Pages” on page 22
- “Using the Video Pages” on page 22
- “Using the 3D Settings Pages” on page 22
- “Using the Licensing Pages” on page 23
- “Using the Workstation Pages” on page 23

Using the Display Pages

The actual tasks available on your system depend on your system hardware, such as the number and type of displays connected. Use the Display group pages to:

- Run the wizard to optimize your display configuration.
- Change the display resolution.
- Change the scaling on your flat panel display.
- Adjust desktop color settings.
- Rotate the display.
- Adjust custom timings.
- Configure multiple displays, including Clone modes.
- Adjust your television picture quality and video color settings for the best possible viewing in its environment.
- Change the position and size of the desktop/video to best fit your television or HDTV (high definition television) screen.
- Change the signal format to use for your standard television or HDTV as well as change country-specific signal or the HDTV format.
- Verify the HDCP capability of your system.
- Access digital audio controls.

Using the Video Pages

The actual tasks available on your system depend on your system hardware, such as whether or not you have a TV connected and enabled. Use the Video page to:

- Adjust video and image color settings.

Using the 3D Settings Pages

The actual tasks available on your system depend on your system hardware, such as whether or not you have an SLI-ready system. Use the 3D Settings page to:
Change the image and rendering settings of your 3D applications and games that utilize Direct3D and OpenGL technology.

Assign specific 3D settings to a game so that these settings automatically load when a game is launched (available under Advanced view).

Set up your SLI or multi-GPU configuration as well as PhysX configuration.

GPU temperature monitoring and GPU overclocking features are not included in the 3D Settings page. To use this functionality you must install NVIDIA nTune software.

Using the Licensing Pages

Use the Licensing pages to obtain licenses for NVIDIA GRID vGPU or NVIDIA Quadro Virtual Datacenter Workstation (Quadro vDWS) on supported Tesla products.

The Licensing pages are available if the vGPU requires a license, or if the GPU or driver supports GRID licensed features.

Using the Developer Pages

Use the Developer pages to control settings specific to developers who need to use NVIDIA developer tools.

Using the Workstation Pages

The Workstation group is available if you have an NVIDIA Quadro graphics card installed.

The actual tasks available depend on which NVIDIA Quadro product you have installed. Use the Workstation page to:

- Synchronize your displays using frame sync or genlock technology.
- View a graphical representation of the displays and graphics cards installed on your system.
- Manage serial digital interface (SDI) output (requires NVIDIA Quadro SDI solution.)
- Configure SLI Mosaic mode to combine multiple displays into a larger virtual canvass.
- Configure ECC control on supported GPUs.
- Overlap the edges of adjacent displays.
  Display edge blending is no longer available.
Appendix A   Using NVIDIA SLI Technology

NVIDIA SLI technology lets you install and benefit from two PCI Express (PCIe) graphics boards in a single PC. Just as dual processors or dual core CPUs improve computer performance, SLI allows dual GPUs (Graphics Processing Units) to significantly accelerate graphics performance.

This chapter explains how to install, configure, and use NVIDIA SLI graphics cards as supported in the Quadro Professional drivers.

► “Overview of SLI Technology for NVIDIA Quadro Cards” on page 25
► “Installation Instructions” on page 27
► “Using NVIDIA SLI Frame Rendering or SLI Antialiasing Modes” on page 29
► “Viewing the SLI Visual Indicators” on page 33
► “SLI Multi-OS – GPU Assignment in System Virtualization” on page 35
► “Mosaic Technology” on page 35
Overview of SLI Technology for NVIDIA Quadro Cards

Professional users benefit by using SLI technology on dual NVIDIA Quadro GPUs to span an OpenGL window across multiple displays, or to run a single application on each GPU. The SLI connector offers dual GPU performance on a single display by leveraging the capabilities of two NVIDIA Quadro GPUs.

SLI Modes for NVIDIA Quadro GPUs

Following is a summary of the SLI functions available for NVIDIA Quadro GPUs:

SLI Frame Rendering Mode

SLI frame rendering combines two PCI Express graphics boards with an SLI connector to transparently scale application performance on a single display by presenting them as a single graphics card to the operating system. SLI frame rendering accelerates OpenGL operation in two different ways:

- Split frame rendering: In split-frame rendering (SFR), the display is split into distinct sections, and each section is sent to a different GPU. The resulting rendering is recomposed and displayed as a single contiguous frame. The position of the split is adjusted dynamically as the workload moves between the GPUs.
  - SFR typically benefits pixel-shader or texture-intensive operations and is used in the 3D App–Visual Simulation profile.

- Alternate frame rendering: In alternate frame rendering (AFR), each GPU renders alternate frames of data from the application.
  - AFR typically benefits geometry-intensive operations and is used in the 3D Apps–Modeling AFR profile. It is also the standard SLI frame rendering method for general use.

SLI Full Scene Antialiasing Mode

SLI antialiasing combines the power of two PCI Express graphics boards to offer higher quality antialiasing.
Hardware Requirements

To support NVIDIA SLI technology, the motherboard and system must include the following:

Motherboard

Your PC motherboard must be PCI Express-based, with two available and adjacent PCI Express expansion slots. Both slots must be x16 mechanical with the following allowed electrical slots:

- x16 + x16
- x16 + x8
- x16 + x4
- x8 + x8

Graphics Cards

NVIDIA SLI requires two SLI graphics cards.
- Two identical NVIDIA Quadro K4200, M4000, K5000, K5200, M5000, K6000, M6000, M6000 24GB, P4000, P5000, and P6000 graphics cards with SLI connector.

Power supply

- Some SLI-ready graphics boards require an external power cable.
- Since NVIDIA SLI technology supports up to two high-end graphics boards, the load on the system’s power supply can increase significantly. A minimum of a 480W Power Supply Unit (PSU) is recommended.
  
  An inadequate power supply will result in erratic and unpredictable system behavior.

See the NVIDIA SLI website for updated hardware requirements information.
Installation Instructions

Before removing current graphics boards and installing two NVIDIA Quadro FX boards, please uninstall any current drivers and save on your Windows desktop the provided SLI drivers.

Installing the Hardware

**Note:** Perform the installation in a static safe environment and utilize a properly grounded anti-static wristband. Place any static sensitive components in anti-static bags.

1. Power off the system and remove the power cord from the power supply.
2. Gently remove or open the system enclosure.
   
   Refer to owners manual that came with your computer.
3. Remove any non SLI-capable graphics boards that may occupy the x16 expansion slot and replace it with your NVIDIA SLI-ready graphics board.
4. Install the second SLI-capable graphics board in the adjacent slot.
   
   You may also need to relocate a card. The chosen slot must be x16, x8 or x4 capable.
5. Connect the two graphics boards with the SLI bridge connector.

The SLI connector is required for SLI Frame Rendering and SLI Antialiasing.

6. If your graphics boards have an auxiliary power connector, connect them to the power supply using the supplied power connector cables.
7. Replace the system’s cover and reconnect your display(s) to the SLI-ready graphics board installed in the x16 expansion slot.
8. Plug the power cable back into the system.
Installing the Display Driver

Follow the steps listed below to install your driver software:

1. Power on the system and log into Windows.
2. Cancel the Windows “Found New Hardware Wizard”.
   This message should appear twice – once for each graphics board.
3. Run “setup.exe” for the SLI driver you saved to your desktop.
4. Follow the “Next” prompts to proceed with driver installation.
5. Once the software has been installed, choose “Yes, I want to restart my computer now” and select “Finish” to reboot the system.

See the following sections for instructions on using NVIDIA SLI Technology:

- “Using NVIDIA SLI Frame Rendering or SLI Antialiasing Modes” on page 29
Using NVIDIA SLI Frame Rendering or SLI Antialiasing Modes

**Note:** Before enabling SLI technology, you must close any 3D applications that are using the NVIDIA driver. When SLI is enabled, the video driver is reset in order to enable the second GPU. If an application that uses the graphics driver is still open while the driver resets, this could result in a black screen or cause the system to hang.

There are two basic steps for using SLI frame rendering and antialiasing modes:

1. **Enable SLI Mode**
2. Select the NVIDIA SLI mode to use:
   - Selecting SLI Frame Rendering
   - Selecting SLI Full-scene Antialiasing
   - Selecting SLI Single-GPU Mode

These steps are described in detail in the following sections.

**Enable SLI Mode**

1. After logging back on to Windows, you should see the message “SLI capable system” in the bottom right corner of the screen.

   ![SLI capable system message](image)

   On some configurations, the message will state that SLI mode is automatically enabled. In that case you can skip the remaining instructions in this section and proceed to “Selecting SLI Frame Rendering” on page 30.

2. Click anywhere on the message.
   
   If the message disappears before you can click it, continue with the following steps.

3. Right click the desktop and click NVIDIA Control Panel.

4. Under the 3D Settings category, click Set SLI configuration.

5. Under Select the SLI configuration, click Maximize 3D performance.
   
   If you plan to use SLI Mosaic mode, click Allow SLI Mosaic Mode.

   The GPU configuration visualizer shows the pending SLI configuration as well as the display connections and enabled state of the displays. The SLI bar indicates the SLI mode (SLI, 3-way SLI, Quad SLI, or 4-way SLI) and points to the GPUs that are used for SLI.

6. Click Apply.
   
   If you have more than one display connected, you can select which display to use as the SLI focus display, or the display to which you want to apply full SLI acceleration for full-screen
applications. Use the Set up multiple displays page to select which SLI display to use as the primary display. This becomes the SLI focus display.

If none of the displays in the SLI group are the primary display, then the driver will select which display to use as the SLI focus display.

To use SLI frame rendering or SLI antialiasing technology, you must configure the SLI performance mode as explained in the next section.

Selecting SLI Frame Rendering

The steps to set up SLI frame rendering depends on whether the application is ACE detectable and a global preset exists for your application.

Refer to "NVIDIA Application Configuration Engine" on page 48 to determine which of the following steps to take:

- SLI Frame Rendering for ACE-Detectable Applications
- SLI Frame Rendering for Non-ACE Detectable Applications with no Global Preset
- Using the Preset 3D App Profiles

SLI Frame Rendering for ACE-Detectable Applications

1. From the NVIDIA Control Panel tool bar, switch to Advanced View and then click Manage 3D Settings from the Select a Task pane.
2. Click the Global Settings tab, and then click the Global presets list arrow and select Base profile.
3. Under the Settings Feature column, locate SLI performance mode, click its setting to activate the list box, then click NVIDIA Recommended.
4. Click Apply.
SLI Frame Rendering for Non-ACE Detectable Applications with no Global Preset

1. From the NVIDIA Control Panel tool bar, switch to Advanced View and then click Manage 3D Settings from the Select a Task pane.
2. Click the Global Settings tab, and then click the Global presets list arrow and select Base profile.
3. Under the Settings Feature column, locate SLI performance mode, click its setting to activate the list box, then click either an AFR 1 or AFR 2 option.
   There may be subtle differences in performance between AFR 1 and AFR 2, depending on the application. You can try each one to determine which provides the best performance with the highest quality for your application.
4. Click Apply.

Using the Preset 3D App Profiles

The following three preset application profiles for OpenGL applications are useful in SLI configurations:

► 3D App-Modeling AFR
   This preset is useful for modeling applications, and uses SLI AFR mode.

► 3D App-Visual Simulation
   This preset is useful for visual simulation applications, and uses SLI SFR mode.

► 3D App-Default Global Settings
   This preset uses SLI single-GPU rendering mode, and is also useful when you need to use non-SLI configurations.

To enable one of these profiles, click the Global Settings tab in the Manage 3D Settings page, then click the Global presets list arrow and click the profile you want to use.
Selecting SLI Full-scene Antialiasing

You can use SLI technology to provide higher-quality antialiasing beyond 16xFSAA. In this mode, SLI frame rendering is not available. To use SLI antialiasing, perform the following steps.

1. From the NVIDIA Control Panel tool bar, switch to Advanced View and then click Manage 3D Settings from the Select a Task pane.
2. Click the Global Settings tab, and then click the Global presets list arrow and select Base profile.
3. Select an SLI antialiasing setting.
   - Locate Antialiasing-Mode, click its setting to activate the list box and then click Enhance the application setting.
   - Locate Antialiasing - Setting, click its setting to activate the list box, then click the SLI antialiasing setting you want to use.
4. Click Apply.

Selecting SLI Single-GPU Mode

SLI single-GPU mode is the default setting, and provides improved performance at a level that assures compatibility with most applications. This is not the same as completely disabling SLI. If you are trying to solve a compatibility issue, you may want to completely disable SLI by clicking Disable SLI on the Manage 3D Settings->Set SLI Configuration page.

To use single GPU mode, perform the following steps.

1. From the NVIDIA Control Panel tool bar, switch to Advanced View and then click Manage 3D Settings from the Select a Task pane.
2. Click the Global Settings tab, and then click the Global presets list arrow and select Base profile.
3. Under the Settings Feature column, locate SLI performance mode, click its setting to activate the list box, then click SLI single-GPU.
4. Click Apply.
Viewing the SLI Visual Indicators

To verify that SLI mode is enabled and that the graphics cards are sharing the load,
1. From the NVIDIA Control Panel Select a Task pane, click Set SLI configuration.
2. From the menu bar, click 3D Settings, then click the drop-down menu item Show SLI Visual Indicators.

This option enables an SLI status bar that reflects how the GPUs are working together to render DirectX and OpenGL full-screen applications. See Figure A.1.

AFR load balancing bar shows relative work provided by each GPU.

SFR load balancing line shows relative portion of the screen rendered by each GPU.

SLI AA indicator shows the effect of SLI antialiasing modes.
Figure A.1  SLI Visual Indicators
SLI Multi-OS – GPU Assignment in System Virtualization

On systems with two supported graphics cards installed, this driver supports a system virtualization tool’s ability to directly assign a GPU to a guest virtual machine (VM). This direct assignment allows the host and guest VM to each run on their own operating system and with their own GPU and driver.

- Supported Virtualization Software: Parallels Workstation Extreme
- Supported Graphics Cards
  - Up to two different models can be used in a system, from among the following:
    - Quadro M6000 (24GB)
    - Quadro M5000, M4000, M2000, K2200
    - Quadro K6000, K5200, K5000, K4200, K4000, K2000

For a list of SLI Multi-OS certified workstations, virtualization software, and OS combinations, please see http://www.nvidia.com/object/sli_multi_os.html.

Mosaic Technology

NVIDIA® Mosaic enables transparent scaling of any application on up to eight displays from two Quadro Plex systems or multiple Quadro cards. Mosaic enables presentation of multiple GPUs (from Quadro Plex systems or multiple supported Quadro cards) as a single logical Quadro GPU to the operating system.

See the NVIDIA Mosaic Technology User’s Guide for additional information.
Appendix B  Multi-GPU Systems

This appendix discusses multi-GPU display configuration in a non-SLI (or SLI Multi-view) configuration. It contains the following sections:

►  "Configuring Multi-GPU Displays in the NVIDIA Control Panel" on page 37
►  "Understanding Multi-GPU Displays in the Windows Display Properties Settings Page" on page 39
Configuring Multi-GPU Displays in the NVIDIA Control Panel

Multi-GPU systems are typically systems with more than one graphics card installed, but they can also include systems with one or more NVIDIA Quadro NVS 810 cards, or one or more NVIDIA Quadro M6000 graphics cards.

In a multi-GPU system, you use the NVIDIA Control Panel to control the multi-display mode (single, Dualview, Clone, or Spanning) in the same manner as you would in a single-GPU system—from the Set up Multiple Displays page.

You can configure displays from several “GPUs” at a time.

On the Set Up Multiple Displays page, the box under Step 1 lists all the displays that are connected to your system, and shows to which GPU they are connected.

Check or clear the check boxes to select the displays that you want to use, then click Apply to activate the new display configuration.

The displays will be in either extended mode or Clone mode.

Extended mode displays are identified by number in separate box icons.

- The numbering corresponds to the numbering in the Windows Display Settings page.
- The Windows primary display is indicated by the box icon with a star.
- To switch from extended mode to Clone mode,
  - Right-click one of the display icons for the display that you want to make a clone, then click the Clone displays option from the pop-up menu.
Select the option that specifies the display that you want to be the primary clone display.

b. Click Apply.

Cloned displays are identified by numbers inside the same box icon.

To switch from Clone mode to extended mode,

a. Right-click the display icon for the display that is physically positioned on the right side, then click Extend desktop on this display from the popup menu.

Right-clicking the box area between the circles has the same effect as clicking the left circle.

b. Click Apply.
Understanding Multi-GPU Displays in the Windows Display Properties Settings Page

The following explanation describes the monitor icons for multiple displays in the Windows Display Properties Settings page.

- Overview of Dualview Monitors in a Multiple-GPU System
- Monitor Order
- Monitor Icons
- Monitor Icons: nView Clone and Spanning Mode
- Determining GPU Order

Overview of Dualview Monitors in a Multiple-GPU System

In Dualview mode, the displays are recognized by the operating system and you can configure each display independently. You can also attach or remove Dualview displays using the Display Properties Settings page.

The monitor ordering is controlled by a combination of the driver and the Windows method of enumerating PCI devices. Because a number of factors are involved in the enumeration of the displays, it can be difficult to predict which display icon in the Windows Display Properties page corresponds to which display connector on the graphic cards.

To accurately determine which icon represents which display,

1. If the display in question is already attached, skip this step. Otherwise, attach the display by right-clicking the icon and clicking Attached, then click Apply.
2. Right click the icon again and click Identify.
   The icon number appears on the display.

Monitor Order

Windows enumerates all display outputs from a GPU before considering the next GPU.
Monitor Order Example

Table B.1 gives an example of four monitors connected to two GPUs, and shows the general pattern the operating system uses to enumerate the monitors:

<table>
<thead>
<tr>
<th>Connector Position</th>
<th>Monitor Number</th>
</tr>
</thead>
<tbody>
<tr>
<td>GPU0—Output 1</td>
<td>1</td>
</tr>
<tr>
<td>GPU0—Output 2</td>
<td>2</td>
</tr>
<tr>
<td>GPU1—Output 1</td>
<td>3</td>
</tr>
<tr>
<td>GPU1—Output 2</td>
<td>4</td>
</tr>
</tbody>
</table>

Monitor Icons

This section describes how monitors are ordered when not all the displays in a multi-GPU system are connected or enabled under Dualview.

- The Display Properties page shows all the monitors that can be supported by the graphics cards in the system, even if they are not physically connected.
- If a display is not connected, or connected but not enabled under Dualview, the corresponding monitor icon is grayed out.

Monitor Order Example

Table B.2 shows the general monitor numbering when only some of the displays are connected. Monitor numbers are always sequential, even when displays are not connected.

<table>
<thead>
<tr>
<th>Connector Position</th>
<th>Connection Status</th>
<th>Monitor Number</th>
</tr>
</thead>
<tbody>
<tr>
<td>GPU0—Output 1</td>
<td>Connected</td>
<td>1</td>
</tr>
<tr>
<td>GPU0—Output 2</td>
<td>Connected</td>
<td>2</td>
</tr>
<tr>
<td>GPU1—Output 1</td>
<td>Connected</td>
<td>3 (grayed)</td>
</tr>
<tr>
<td>GPU1—Output 2</td>
<td></td>
<td>4 (grayed)</td>
</tr>
<tr>
<td>GPU2—Output 1</td>
<td>Connected (not enabled)</td>
<td>5 (grayed)</td>
</tr>
<tr>
<td>GPU2—Output 2</td>
<td></td>
<td>6 (grayed)</td>
</tr>
</tbody>
</table>
Monitor Icons: nView Clone and Spanning Mode

Only outputs from the same GPU can be grouped together in nView Span mode or nView clone mode.

When you enable nView Clone mode, Windows recognizes only the nView primary display as connected, and the display corresponding to the nView secondary clone mode display is shown to be not attached in the Display Properties Settings page.

When you enable nView Horizontal or Vertical Spanning mode, Windows recognizes only the nView primary display as connected, and considers it to have a resolution equal to the combined resolutions of both displays. The display corresponding to the nView secondary spanning mode display is shown to be not attached in the Display Properties Settings page.

Determining GPU Order

The following are guidelines to help determine the order in which GPUs are considered when the operating system enumerates displays.

Default GPU Order

Table B.3 shows which GPU is designated as GPU0 for the purpose of monitor ordering in a multiple-GPU system.

Table B.3  Windows Monitor Numbering Example—Default Boot Priority

<table>
<thead>
<tr>
<th>Configuration</th>
<th>Which GPU is considered first</th>
</tr>
</thead>
<tbody>
<tr>
<td>AGP + PCI</td>
<td>GPU on the AGP bus [by default]</td>
</tr>
<tr>
<td>PCI-E + PCI</td>
<td>GPU on the PCI-E bus [by default]</td>
</tr>
<tr>
<td>NVIDIA Quadro NVS 400 (or other multi-GPU graphics cards)</td>
<td>GPU driving the monitor connector closest to the card edge connector.</td>
</tr>
<tr>
<td>NVIDIA Quadro NVS 440</td>
<td>GPU driving the monitor connector farthest way from the card edge connector.</td>
</tr>
</tbody>
</table>

Monitor Order After Changing the GPU Boot Priority in the BIOS

By default, in a multi-graphics card system the AGP or PCI-E bus has boot priority in the system BIOS, meaning that GPU0 resides on the AGP or PCI-E graphics card and displays are enumerated beginning with that GPU.
If you change the boot priority to the PCI bus, displays are enumerated in the same order except that the first display is enumerated from the GPU on the PCI bus. After that, the GPUs and displays are enumerated in the standard priority, as shown in Table B.4.

Table B.4  Windows Monitor Numbering Example–PCI Boot Priority

<table>
<thead>
<tr>
<th>Connector Position</th>
<th>Monitor Number</th>
</tr>
</thead>
<tbody>
<tr>
<td>GPU0 (AGP/PCI-E)—Output 1</td>
<td>3</td>
</tr>
<tr>
<td>GPU0 (AGP/PCI-E)—Output 2</td>
<td>4</td>
</tr>
<tr>
<td>GPU1 (AGP/PCI-E) —Output 1</td>
<td>5</td>
</tr>
<tr>
<td>GPU1 (AGP-PCI-E) —Output 2</td>
<td>6</td>
</tr>
<tr>
<td>GPU2 (PCI) —Output 1</td>
<td>1</td>
</tr>
<tr>
<td>GPU2 (PCI) —Output 2</td>
<td>2</td>
</tr>
</tbody>
</table>
This appendix discusses professional or quad-buffered 3D stereo. It contains the following sections:

- “About Workstation 3D Stereo” on page 43
- “Using Workstation 3D Stereo” on page 44

About Workstation 3D Stereo

The NVIDIA graphics driver comes with built-in support for 3D stereoscopic viewing of OpenGL applications developed for 3D stereo. This is also referred to as “professional”, “workstation”, or “quad-buffered” stereo.

Basic Workstation 3D Stereo Requirements

To use workstation stereo, you need the following:

- OpenGL application that is developed for stereo
  
  The application must be designed to render different content to the left and right eye.
- NVIDIA Quadro graphics card, except NVIDIA Quadro NVS cards
- Proper driver configuration through the NVIDIA Control Panel

---

1. This is not to be confused with the NVIDIA consumer 3D stereo driver that lets you view 3D applications in stereo even if they are not developed for stereo.
Using 3D Stereo under Different System Configurations

The NVIDIA drivers support both full-screen and windowed stereo. Table C.1 details which stereo modes are supported under which GPU/display configurations.

Table C.1  Workstation Stereo Configurations

<table>
<thead>
<tr>
<th>System Configuration</th>
<th>Active Stereo Display Modes</th>
<th>Passive Stereo Display Modes</th>
</tr>
</thead>
<tbody>
<tr>
<td>Single GPU - Single display</td>
<td>Supported</td>
<td>Supported</td>
</tr>
<tr>
<td>Single GPU - Multiple displays</td>
<td>Not supported</td>
<td>Supported (including CloneMode)</td>
</tr>
<tr>
<td>Multi-system - Multiple displays</td>
<td>Not supported</td>
<td>Not supported</td>
</tr>
<tr>
<td>Multi-GPU Mode</td>
<td>Not supported</td>
<td>Supported (including CloneMode)</td>
</tr>
<tr>
<td>SLI mode</td>
<td>Not supported</td>
<td>Not supported</td>
</tr>
</tbody>
</table>

Using Workstation 3D Stereo

Basic 3D Stereo Setup

1. Set up the 3D stereo viewing hardware according to the instructions that came with your hardware.
2. Start the system, then right-click the desktop and click NVIDIA Control Panel to open the panel.
3. From the Select a Task pane, click Manage 3D Settings, then click the Global Settings tab.
4. Under the Settings: Feature column, click Stereo - Enable, then click the corresponding Setting list arrow and select On.
5. Click Apply.
6. From the Select a task pane, under Stereoscopic 3D, select Set up stereoscopic 3D to open the associated page.
7. Make sure the Enable stereoscopic 3D check box is cleared, then click Apply.
Selecting the Stereo Display Mode

Typically, the driver detects the type of stereo hardware that is installed and automatically selects the appropriate display mode. If you cannot view 3D stereo with your application after these steps, then manually select the display mode as follows:

1. Re-open the Global Settings tab in the NVIDIA Control Panel Manage 3D Settings page.
2. Under the Settings: Feature column, click Stereo - Display mode, then click the corresponding Setting list arrow and select the stereo display mode that is appropriate for your stereo viewing hardware.
   - See Table C.2, "List of Supported Stereo Display Modes" on page 45 for a description of the available modes.
   - If you want to use passive stereo using nView Clone mode, be sure to set up Clone mode using the Set Up Display Configuration page.
3. Click Apply.

Table C.2 List of Supported Stereo Display Modes

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
<th>Hardware Examples</th>
</tr>
</thead>
<tbody>
<tr>
<td>On-board DIN connector</td>
<td>Time sequential, page-flip stereo, with stereo shutter glasses connected directly to a 3-pin DIN VESA connector.</td>
<td></td>
</tr>
<tr>
<td>On-board DIN connector (with NVIDIA IR Emitter)</td>
<td>Time sequential, page-flip stereo, with NVIDIA IR emitter connected to the 3-pin DIN VESA connector via dongle.</td>
<td>NVIDIA GeForce 3D Vision</td>
</tr>
<tr>
<td>Generic active stereo</td>
<td>Any time sequential, page-flip stereo</td>
<td>Displays which accept time-sequential stereo signals</td>
</tr>
<tr>
<td>Generic active stereo (with NVIDIA IR Emitter)</td>
<td>Any time sequential, page-flip stereo using the NVIDIA IR emitter</td>
<td>NVIDIA GeForce 3D Vision</td>
</tr>
<tr>
<td>nView Clone Mode</td>
<td>Uses projectors from two displays in nView Clone mode–left image on one display, right image on the other. Passive polarized filters (glasses) isolate the left and right images to the corresponding eyes of the viewer.</td>
<td>Dep3D System</td>
</tr>
</tbody>
</table>
Table C.2  List of Supported Stereo Display Modes (continued)

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
<th>Hardware Examples</th>
</tr>
</thead>
<tbody>
<tr>
<td>nView Clone Mode (with NVIDIA IR Emitter using external stereo signal)</td>
<td>Clone mode passive to active stereo conversion - the left/right images are displayed through separate monitor outputs and converted to active stereo by the display. The display feeds the stereo toggle signal into the NVIDIA IR emitter using a 3-pin DIN stereo cable.</td>
<td>projectiondesign F10</td>
</tr>
<tr>
<td>Vertical interlaced stereo monitor</td>
<td>Vertical pixel columns alternate between left and right images. A beam splitter directs the left and right images to the corresponding eyes of the viewer.</td>
<td>SeeReal Technologies</td>
</tr>
<tr>
<td>Color interleaved display</td>
<td>Custom implementation for the Sharp 3D Display, an auto-stereoscopic display that uses a parallax barrier technology to provide 3D stereo on the LCD.</td>
<td>Sharp3D Stereo Digital Flat Panels</td>
</tr>
<tr>
<td>Horizontal interlaced stereo display</td>
<td>Horizontal scan lines alternate between left and right images. Passive polarized filters (glasses) isolate the left and right images to the corresponding eyes of the viewer.</td>
<td>VReX, Inc.</td>
</tr>
<tr>
<td>3D DLP display</td>
<td>Projector or rear projection TV using Texas Instrument’s Digital Light Processing (DLP) technology. Requires shutter glasses.</td>
<td>Samsung or Mitsubishi DLP HDTV with shutter glasses</td>
</tr>
<tr>
<td>3D DLP display (with NVIDIA IR Emitter)</td>
<td>Projector or rear projection TV using Texas Instrument’s Digital Light Processing (DLP) technology. Requires NVIDIA GeForce 3D Vision IR emitter.</td>
<td>Samsung or Mitsubishi DLP HDTV with NVIDIA GeForce 3D Vision</td>
</tr>
<tr>
<td>3D DLP display INV mode</td>
<td>Use if the &quot;3D DLP display&quot; option results in reversed eyes.</td>
<td>Samsung or Mitsubishi DLP HDTV with shutter glasses</td>
</tr>
<tr>
<td>3D DLP display INV mode (with NVIDIA IR Emitter)</td>
<td>Use if the &quot;3D DLP display (with NVIDIA IR Emitter) &quot; option results in reversed eyes.</td>
<td>Samsung or Mitsubishi DLP HDTV with NVIDIA GeForce 3D Vision</td>
</tr>
</tbody>
</table>
Using Workstation 3D Stereo with Multiple Displays

In a multi-display system, you can move the OpenGL application window to all monitors, although stereo might not be visible on all monitors.

Enabling 3D Stereo with Multiple Displays

To make sure that you successfully enable 3D stereo in a multi-display configuration and avoid losing stereo settings, NVIDIA recommends first enabling stereo in single-display mode and then closing the NVIDIA Control Panel before setting up multi-display modes.

1. Enable 3D stereo
   a. Open the NVIDIA Control Panel, then set single-display mode using the Set Up Multiple Displays page.
   b. Set stereo settings using the Manage 3D Settings page.
   c. Close the NVIDIA Control Panel.

2. Enable multiple displays
   Using either the Windows Display Properties page or by re-opening the NVIDIA Control panel-Set up Multiple Displays page, set the desired multi-display mode.

3. Set up other NVIDIA Control Panel->Workstation settings as needed, such as frame locking.

3D Stereo Under nView Modes

Under nView multi-display modes, both displays must be set to the same resolution and refresh rate. If the refresh rates are different, the 3D stereo will be displayed on the display with the highest refresh rate.

3D Stereo Under Dualview Modes

Under Dualview mode, all displays must be set to the same refresh rate for 3D stereo to be displayed on all the Dualview displays. If the refresh rates are different, 3D stereo will be displayed on the display with the highest refresh rate.
Appendix D  NVIDIA Application Configuration Engine

This appendix discusses the NVIDIA application configuration engine (ACE) for professional workstation applications. It contains the following sections:

► “Introduction” on page 49
► “Using ACE with Supported Applications” on page 49
► “Using Applications that are not Supported by ACE” on page 51
► “Adding to the List of ACE-detectable Applications” on page 53
► “Frequently Asked Questions” on page 54
Introduction

Background

Workstation application profiles are a group of software settings used by the NVIDIA graphics driver to provide optimum performance when using a selected application. If there is an available profile for an application, it should be used in order to ensure correct application behavior and optimal performance.

About NVIDIA ACE

With the NVIDIA application configuration engine (ACE), the graphics driver can now detect supported workstation applications and apply the appropriate profile settings automatically—you no longer need to manually select the profile from the NVIDIA Control Panel. If you run more than one application at a time, ACE makes sure that the driver applies the appropriate profile settings to each application.

Using ACE with Supported Applications

When you run an application that is supported by ACE, you do not need to do anything special. The driver will detect the application and apply the appropriate profile settings automatically.

How to Determine ACE Support

To determine whether your application is supported by ACE:

1. Open the NVIDIA Control Panel.
2. From the Select a Task pane, under 3D Settings, click Manage 3D Settings, then click the Program Settings tab.
The Select a program to customize list box contains a list of the ACE-detectable applications.

Figure D.1 Manage 3D Settings Page–ACE-detectable applications

Modifying Settings for ACE-detectable Applications

You can modify the settings as follows:

1. Select the application from the Select a program to customize box.
   The settings for the application are listed in the Specify the settings for this program box.
2. Click the setting you want to change and then select the new setting from the drop-down list.
3. Click Apply when you are finished making your changes.
Using Applications that are not Supported by ACE

If your application is not detectable by ACE, then you should configure an application profile and make sure it is set before running the application.

Setting Up an Application Profile Using Global Presets

1. From the Manage 3D Settings page, click the Global Settings tab.
2. Click the Global Presets list arrow.

![Manage 3D Settings Page—Applications with Global Profiles](image)

3. Select one of the global presets:
   - Select a Base profile or one of the generic 3D App profiles, or create a new profile (see “Adding to the List of ACE-detectable Applications” on page 53).
4. In the Settings box, you can modify the profile by clicking the setting you want to change and then selecting the new setting from the drop-down list.
5. Click Apply when you are finished making your changes.

If you run a different application that is not ACE-detectable and do not want to use these settings, then repeat these steps for the new application.

Be aware that these settings may affect any ACE profile settings that specify “Use global setting”.
About the Global Presets

Global profiles, or presets, are a set of 3D settings that the driver applies to any workstation application. While a specific profile contains settings that work best with a particular application, the settings are applied to any workstation application you run, as long as there are no ACE-detected program settings to override them.

The following are descriptions of the available global presets:

- **Base profile**
  This preset lets you configure all the settings, and provides the most flexibility. Other presets allow you to configure only a limited selection of settings.

- **3D App - Default Global Settings**
  This preset uses SLI single-GPU rendering mode, and is also useful when you need to use non-SLI configurations.

- **3D App - Game Development**
  This preset is useful for game development when using an NVIDIA Quadro card. This eliminates the need for game developers to switch to a GeForce graphics card as the settings cause the Quadro card to run like a GeForce card.

- **3D App - Modeling AFR**
  This preset is useful for modeling applications, and uses SLI AFR mode.

- **3D App - Visual Simulation**
  This preset is useful for visual simulation applications, and uses SLI SFR mode.
Adding to the List of ACE-detectable Applications

If your application is not listed in any of the profile lists in the Global Settings or Program Settings tab, then you can create a profile for that application as follows:

**Note:** If your application is listed in the Global Settings tab (Windows XP only), then **do not create a new profile.** Set the global preset for that application instead.

1. From the Manage 3D Settings page, click the Program Settings tab.
2. Click Add.
3. In the Open dialog box, navigate to the location of your application executable, then click the executable file name and click Open.
4. The file name appears in the Select a program to customize list box.
5. In the Specify the settings for this program box, configure any settings by clicking the setting you want to change and then selecting the new setting from the drop-down list.
6. Click Apply when you are finished making your changes.

The new profile will be applied automatically whenever the application is run, just like one of the default ACE profiles.

If your application was running while you created the new profile, you must restart the application in order for the settings to be applied.
Frequently Asked Questions

- What happens when I run more than one ACE-detectable application at the same time?
  The driver detects each application and applies the appropriate profile to each one automatically.

- What happens when I run an ACE-detectable application and a non-ACE-detectable application at the same time?
  The driver applies the global preset to the non-ACE-detected application, and applies the appropriate profile to the ACE-detected application. Note that any settings in the ACE profile that specify “Use global setting” will be controlled by the global preset.

- Can I create my own application profile?
  Only one profile can be created for a specific executable, so if your application is ACE-detectable, do not create another profile for that application.
  
  If your application is not ACE-detectable, and there is no global preset for it, then you can create a new profile as described in “Adding to the List of ACE-detectable Applications” on page 53.

- Can I create a new global profile for a specific application?
  For applications that are not detected by ACE, you can select an existing global preset and customize it, but you will not be able to save it under a custom name.

- Which global preset should I use?
  Unless you know that a specific global preset is appropriate for your application (see “About the Global Presets” on page 52), it is best to use the Base profile.
Notice

ALL NVIDIA DESIGN SPECIFICATIONS, REFERENCE BOARDS, FILES, DRAWINGS, DIAGNOSTICS, LISTS, AND OTHER DOCUMENTS [TOGETHER AND SEPARATELY, "MATERIALS"] ARE BEING PROVIDED "AS IS." NVIDIA MAKES NO WARRANTIES, EXPRESSED, IMPLIED, STATUTORY, OR OTHERWISE WITH RESPECT TO THE MATERIALS, AND EXPRESSLY DISCLAIMS ALL IMPLIED WARRANTIES OF NONINFRINGEMENT, MERCHANTABILITY, AND FITNESS FOR A PARTICULAR PURPOSE.

Information furnished is believed to be accurate and reliable. However, NVIDIA Corporation assumes no responsibility for the consequences of use of such information or for any infringement of patents or other rights of third parties that may result from its use. No license is granted by implication of otherwise under any patent rights of NVIDIA Corporation. Specifications mentioned in this publication are subject to change without notice. This publication supersedes and replaces all other information previously supplied. NVIDIA Corporation products are not authorized as critical components in life support devices or systems without express written approval of NVIDIA Corporation.

HDMI

HDMI, the HDMI logo, and High-Definition Multimedia Interface are trademarks or registered trademarks of HDMI Licensing LLC.

Macrovision Compliance Statement

NVIDIA Products that are Macrovision enabled can only be sold or distributed to buyers with a valid and existing authorization from Macrovision to purchase and incorporate the device into buyer’s products.

Macrovision copy protection technology is protected by U.S. patent numbers 5,583,936; 6,516,132; 6,836,549; and 7,050,698 and other intellectual property rights. The use of Macrovision's copy protection technology in the device must be authorized by Macrovision and is intended for home and other limited pay-per-view uses only, unless otherwise authorized in writing by Macrovision. Reverse engineering or disassembly is prohibited.

OpenCL

OpenCL is a trademark of Apple Inc. used under license to the Khronos Group Inc.

Trademarks

NVIDIA and the NVIDIA logo are trademarks or registered trademarks of NVIDIA Corporation in the United States and other countries. Other company and product names may be trademarks of the respective companies with which they are associated.

Copyright

© 2020 NVIDIA Corporation. All rights reserved.